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retrieval system, or translated into any language or any computer

language, in any form or by any third party, without prior
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DISCLAIMER
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TRADEMARKS
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SOFTWARE LICENCE AGREEMENT

This is a legal agreement between you, the end-user and International Technology Consultants Ltd. BY OPENING THE
SEALED DISK PACKAGE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT,
PROMPTLY RETURN THE UNOPENED DISK PACKAGE AND THE ACCOMPANYING ITEMS (including written
materials and binders or other containers) TO THE PLACE YOU OBTAINED THEM FOR A FULL REFUND. The en-
closed International Technology Consultants Ltd. product is a single user version unless your product’s packaging indicates
otherwise or unless you have written agreement with International Technology Consultants Ltd.

ITC SOFTWARE LICENCE
1. GRANT OF LICENCE

(a) International Technology Consultants Ltd. grants the user a Licence to use one copy of the enclosed software
program (“the Software”) on a single terminal connected to a single computer (i.e. with a single CPU). The end-user may
copy the software from one single terminal to another single terminal or portable or home computer or terminal belonging to
or used by the end-user provided that the software is in use on only one computer at a time and is never installed on more
than two computers at any one time and is used only by the end-user.

(b) If the end-user has multiple Licences for the software, then at any time the end-user may use as many copies
of the software as the end-user has Licences. If the number of persons who can access and use the software exceeds the
number of Licences that the end-user has, then the end-user must have a reasonable mechanism or process in place to assure
that the number of persons using the software at the same time does not exceed the number of Licences.

(c) This Licence is not a sale of any of the rights of ownership of the original software or any copy. In particular
International Technology Consultants Ltd. retains title and full rights of ownership in the original or any copy of the software
installed or copied or in use on all such physical media or on any other media such as, but not restricted to, floppy or hard
disks, CD-ROM or similar storage devices or operating memory.

(d) As the end-user is simply acquiring a licence to use this product, it may therefore not be sold, leased or
transferred to anyone without prior consent of International Technology Consultants Ltd. After written notification to
International Technology Consultants Ltd., the end-user may transfer all copies of the software (including the original) and
the documentation on a permanent basis to another person or entity, provided that the end-user retains no copies of the
software or documentation and that any authorised transferee of the software shall be bound by the terms and conditions of
this Agreement. If the software is an update, any transfer must include the update and all prior versions.

2. COPYRIGHT
The software is owned by International Technology Consultants Ltd. or its suppliers and is protected by the

English copyright laws, international treaty provisions, and all other applicable national legislation. Therefore, you must
treat the software like any other copyrights material (e.g. a book or musical recording) except that if the software is not copy
protected you may either (a) make one copy of the software solely for backup or archival purposes, or (b) transfer the
software to a single hard disk provided you keep the original solely for back up or archival purposes. You may not copy the
product manual(s) or written materials accompanying the software.

3. OTHER RESTRICTIONS
The software and the enclosed written materials are copyrighted and for the avoidance of doubt, the following

are absolutely prohibited without the express prior written consent of International Technology Consultants Ltd.: 1)
Unauthorised copying of the software (or of the written materials), including software that has been modified, merged or
included with other software; 2) Translating any of the software; 3) Reverse-engineering, disassembling, decompiling, or
making any attempt to discover the source code of any of the software; 4) Sub-licensing, renting or leasing any portion of
the software, or operating any of the software on or from a network or mainframe system; 5) Using a previous version of
the software for which you have acquired an upgrade or update, except that for a period of ninety (90) days after you
receive the upgrade or update you may use the previous version solely to convert existing documents to the upgraded or
updated version. At the end of the ninety (90) days, the previous version must be deleted from the computer and the original
disks must be physically destroyed.
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4. LIMITED WARRANTY
International Technology Consultants Ltd. warrants that (a) the SOFTWARE will perform substantially in

accordance with the accompanying product manual(s) for a period of NINETY (90) days from the date of receipt; and
(b) software will be free from defects in materials and workmanship under normal use and service for a period of ONE
(1) year from the date of receipt. Any implied warranties on the software are limited to NINETY (90) days.

5. CUSTOMER REMEDIES
International Technology Consultants Ltd.’s entire liability and your exclusive remedy shall be, at International

Technology Consultants Ltd.’s option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that
does not meet International Technology Consultants Ltd.’s limited warranty and which is returned to International Technology
Consultants Ltd. with a copy of your receipt. This limited warranty is void if failure of the SOFTWARE has resulted from
accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty
period or THIRTY (30) days, whichever is the longer.

6. NO OTHER WARRANTIES
International Technology Consultants Ltd.  disclaims all other warranties, either express or implied, including

but not limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the software, the
accompanying product manual(s) and written materials. This limited warranty gives specific legal rights.

7. LIMITATIONS ON LIABILITY
In no event shall International Technology Consultants Ltd. or its suppliers be liable for any damages  whatsoever

(including, without limitation, damages for loss of business profits, business interruption, loss of business information or
other pecuniary loss) arising out of the use or inability to use this International Technology Consultants Ltd. product, even
if   International Technology Consultants Ltd. has been advised of the possibility of such damages. In any case, International
Technology Consultants Ltd.’s entire liability under any provision of this agreement shall be limited to the amount actually
paid by you for the SOFTWARE.

This agreement is governed by the laws of England and Wales.

Should you have any questions concerning this agreement, or if you desire to contact International Technology Consultants
Ltd. for any reason, please write to: International Technology Consultants Ltd., 26 Victoria Way, Burgess Hill, West
Sussex, RH15 9NF, United Kingdom.
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Introduction to PeripheralVision®

PeripheralVision® is a network management tool developed to enable
comprehensive monitoring, organisation and graphical design of your office
network, WAN (Wide Area Network) and the Internet beyond.  Its key
features include:

Discovery facilities to find the hardware attached to your network
The discovery facilities can be configured to query your network in a number
of ways to find the attached hardware.  Once a device (agent) is found, it
will be identified by PeripheralVision® and an icon representing the device
will be displayed, complete with a title, on the PeripheralVision® map.

Detailed property pages enabling remote management of devices
Extensive property pages are available for each discovered device.  These
can be interrogated for device information, status etc. and can be used to
remotely manage the device (for instance, a printer could be set on/off line,
reset, paper trays can be changed - all remotely from the PC on which
PeripheralVision® is installed).  The level of remote configuration available
will vary depending on the printer model.

Comprehensive monitoring facilities
Extensive device monitoring capabilities enable PeripheralVision® to
configure sound and email alerts to notify of problems with the hardware
on the network.  Logging and graph abilities are available to record hardware
performance.

Design graphical representations of your network
The PeripheralVision® map enables you to design graphical representations
of your network.  Peripherals recognised to be on the same part of the
network will be automatically cabled together, use the facilities to tailor the
map to arrange a screen layout to represent your office/s.

This manual will guide you through the installation of your
PeripheralVision® software and enable you to use its potential to the full.
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Chapter 1
Installation

TCP/IP

Check that you are running TCP/IP and have a valid IP address assigned
to your workstation.  If you do not have a valid TCP/IP address assigned to
your workstation, refer to the Installation Notes as described in Appendix
B of this manual.

CD Installation on Windows 95/98 and NT 4.0

Important: Before installing PeripheralVision® ensure that you exit all
Windows programs.

1 Insert the PeripheralVision® CD-ROM in your drive and wait a few
moments.

2 You will be presented with a message window telling you that you are
installing PeripheralVision®.

3 Click Yes to continue.  After a few moments a window appears.

4 Click on Cancel if you have any Windows programs open.  Close them
down and restart the procedure.

5 Click on Next to continue.  The following window will tell you that the
default directory for PeripheralVision® is:

C:\Program Files\Ringdale\PeripheralVision

and will give you the opportunity to change this if you wish.

6 Click on Next to continue.
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The following window will look similar to this:

7 Clicking on the Change button will present you with the following
dialog box which contains installation options:
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The options are:

Pre-defined Alert Sounds (for further information about the sound facilities
see Chapter 4).  This will install sound files for use in PeripheralVision®.  If
your PC doesn’t have a sound card, or you wish to assign alert sounds of
your own, you probably will not require this option.

PlotPro Desktop is a program that allows viewing and printing of Raster,
AutoCAD DWG and DXF files to plotters.

Software Licence Drivers is an option for Windows NT4 only, and is
automatically installed with PeripheralVision® whether this option is selected
or not.  Use this option only if the drivers need to be reloaded separately at
a later date.

8 If any items are selected that you do not want to install, click in the box
next to them to deselect them.

Both of these dialog boxes will display the space required to install the
software as well as the space available.  You can leave these screens without
installing software by choosing Cancel or Back (or Continue then Cancel
or Back from the Changes dialog box).

9 Once you have selected the options you require, click on Continue then
Next to continue.  Follow the simple instructions to complete the
installation.  The program will load and the program installer will
automatically place an icon in your Start directory.

10 The final window gives you the option of  restarting your computer
without running through the close down procedure.  Remove the CD
from the drive, check that Restart my computer now is selected and click
on Finish.   After the re-boot is finished the installation will be complete.
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Installing the SNMP Agent (optional)

This installation is an option which enables your workstation to increase
the functionality of its relationship with a large range of other machines,
but is not necessary to ensure the operation of PeripheralVision® itself.
SNMP (Simple Network Management Protocol) is the accepted standard
protocol for LANs (Local Area Networks).  You must install the SNMP
agent on your workstation and on the other machines in your office to get
the full benefits of the protocol .

Microsoft’s SNMP agent can be found on the Windows 95 and Windows
NT installation CDs.

To Install SNMP on Windows 95/98:

1 From the Start menu select Settings and then Control Panel.

2 Select Network.

3 Press the Add button.

4 Select Service from the list and then press Add again.

5 Now press the HaveDisk button.

6 At the prompt supply the path D:\ADMIN\NETTOOLS\SNMP
(assuming D is your CD drive) for Windows 95.

or D:\TOOLS\RESKIT\NETADMIN\SNMP (assuming D is your CD
drive) for Windows 98.

7 Press OK.

8 Select the Microsoft SNMP agent option.

9 Click on the OK button for all windows including the Network
configuration screen.



13

You will see a  progress bar with a title Building Driver Database.  An error
may occur here on Windows 95 and it will ask for the Installation CD again,
even though it is already in the CD Drive.  This error occurs because the
program is looking in the wrong area of the disk (this is a Windows 95 error
and not a PeripheralVision® error).  If this happens, change the directory to
D:\WIN95 (the normal install path).

10 Press OK and the SNMP installation will be complete after a re-boot.

To Install the SNMP Agent on Windows NT:

1 From the Start menu select Settings and then Control Panel.

2 Select Network.

3 Select Services property page by clicking on the tab.

4 Select the Add button.

5 Scroll down the list and find SNMP Service.  Click on it to select it.

6 Click OK. The following window will appear:

7 Click on Continue (assuming D is your CD drive). The SNMP agent will
be loaded from the CD.
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8 After the SNMP agent has been loaded, ensure that SNMP Service is
still highlighted, and then click on the Properties button.

9 If Agent is not the default page, select it.

10 Click OK to exit.  The procedure will be complete after a re-boot.

Uninstalling PeripheralVision®

1 To uninstall PeripheralVision®, select Programs from the Start menu,
then PeripheralVision®.  Click on Uninstall PeripheralVision®.  You
will see the following message box:

2 To completely remove PeripheralVision® and all of its components, select
Yes.  The Uninstall Shield application will begin automatically uninstalling
PeripheralVision®.   Alternately, select No to retain your installed version
of PeripheralVision®.
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Chapter 2
Operating PeripheralVision®:  Discovery

To start PeripheralVision®:

Select Start > Programs > PeripheralVision® > PeripheralVision® 1.6.

Wait a few moments.  You will then be presented with the following empty
Map Screen:

Discovery and Related Functions

Discovering your LAN (Local Area Network)
If the program is left to start up on its own, then it will automatically send
out a  NPMP™ (Network Peripheral Management Protocol) broadcast on
your LAN after 30 seconds.  Any devices discovered will appear on the
map screen as icons.
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An example of how the screen will appear is shown below:

Each icon denotes a network device (agent).  PeripheralVision® identifies
the type of device it is (for example a printer, a PC, a hub or router) and then
chooses an icon to represent it.  Most makes of printer will be specifically
identified (for example Kyocera, Epson, and Hewlett Packard  printers will
be recognised and each will have its own icon).

In addition, symbols appearing on the icons provide information regarding
the functionality and the status of the machine.  The NPMP™ probe updates
the status of the NPMP™ devices on the network every 30 seconds
automatically (this feature is adjustable.  For further details see the section
Expanding Your Discovery Abilities, which is found later in this chapter).

Explanations for these symbols are as follows:

FTP superimposed on agent
Agent has File Transfer Protocol (FTP) accessibility
enabling use of a FTP probe (for further details see section
FTP Access later in this chapter).
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Globe icon superimposed on agent
Agent has HTML abilities, enabling it to be interrogated
using a web browser (for further details see section Web
Browser later in this chapter).

Large red cross superimposed on agent
Agent currently not responding.
When the machine comes back on to the network the red
cross will disappear.

Large question mark superimposed on agent
Agent hardware type cannot be identified.
User can choose type from property pages.

Thumbs down icon superimposed on agent
Invalid NPMP™ IP address detection.
IP address is incorrectly configured, use property page
to change this (see Chapter 3).

Round, green P icon superimposed on agent
Agent is currently printing.

Exclamation mark superimposed on agent
Agent currently has an error e.g. out of paper.
To find out more specific details of the problem see agents
property pages or hold cursor over agent and study the
Cursor Bar at the bottom of the screen.

T N superimposed on agent
Agent has TELNET accessibility, enabling use of a
TELNET utility (for further details see section TELNET
later in this chapter).

IPS superimposed on agent
Agent has Ringdale Internet Printing System™ software
installed and running.

Each of these symbols can be turned off if required, see section Configure
Machine Display Page in chapter 4.
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PeripheralVision® Toolbar
PeripheralVision® functions can be accessed by clicking on the toolbar
icons.  The drop-down menus also give access to all  functions.

Locate this PC
This function will enable you to locate your own workstation.
When you select OK from the dialogue box, your PC will appear
as an icon on the map screen, along with other machines from
your LAN that you have communicated with recently.

Expanding your discovery abilities

Locate NPMP™
This is a toolbar function that discovers NPMP™ compatible
devices.  Clicking on the button will bring up the dialog box
below.

Local Network, which appears by default, enables the local
network devices to appear automatically at start-up.  If  you do
not require this facility, click on Don’t interrogate network using
NPMP.
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Ping Locater
This toolbar button is used for discovering agents with a valid
IP address on the selected network(s).  It operates in the same
way as the Locate NPMP™ function above but can discover a
greater diversity of agents.

DNS Agent Discovery
This is an agent search facility that will retrieve IP address and
host name pairs from a DNS (Domain Name Server). When this
option is selected, a dialog box will appear as shown at the top
of the next page.

1 Enter an IP address into the upper text box on the left side of the dialog
box (if you need more information on IP addresses see Appendix B).

2 Click on the Add button.  The IP address will be loaded into
PeripheralVision® and will appear in the lower, larger box .

3 Click OK to close the page.  The discovered device will appear on your
network map.

Alternatively, by running a sub-net search you can locate other agents.
Repeat the procedure above, but enter an IP address ending in * to query
a whole subnet, i.e.  199.2.21.*, or 199.2.21.21-50 for a range of addresses.
This will find machines running TCP/IP on that sub-network.  For further
information on TCP/IP addresses, see Appendix B.

The box marked Poll Rate enables you to vary the time the NPMP™ probe
updates the status of the NPMP™ devices on the network.  The default is
30 seconds but can be adjusted both up and down.

To discover a NPMP™ compatible device using the NPMP IP Network(s)
dialog box:
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The IP address and host name pair for your own network appear in the
boxes by default, allowing you to discover other agents on your network.

To discover a greater number of agents:

1 Enter another DNS IP address in the IP Address of Domain Name Server
text box.

2 Type domain to be searched for in the Domain Name text box.

3 If you want to discover more than 150 agents from a  DNS, select the
specific amount from the Number of agents to discover scroll box.

4 Click OK.

Configure Discovery
A toolbar function that provides an alternative access to the
four previously described functions.  Pressing Configure
Discovery produces a menu of the previous named discovery
buttons.  Select the one required by clicking on its name and
proceed as previously described.
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Further Discovery Functions - DNS Lookup

Using DNS Lookup, you can discover the IP address and/or aliases
associated with either an IP address or host/domain name.  This is not the
same function as DNS Agent Discovery.  To access DNS Lookup:

1 Click on an agent on the map screen with the right mouse button.  You
will see the following menu:

2 Select DNS Lookup.  You will see the
window shown below:

3 Enter an IP Address or Host/Domain Name into the designated box.
Examples of host/domain names are www.ringdale.com or www.nptf.org.
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4 Select either Lookup using IP address or Lookup using host/domain
name from the Type of Lookup box.

5 Lookup Details: When you have typed in the information for the DNS
Lookup, select this button and PeripheralVision® will attempt to discover
additional information for you.

6 Apply to Agent:  Select this button to apply your discovery to the
currently selected agent.

7 Clear All Fields: To clear all the data ready for a new lookup, click on
this button.

Lookup Results

Addresses for this hostname: IP addresses for the given hostname will
appear here.  This address can then be entered into a Ping, Search DNS, or
NPMP™ autodiscovery dialog box.

Aliases for this hostname: Aliases for the given hostname appear here.

Web Browser

This feature launches an Internet web browser, if one is installed.  You must
provide the web browser application.  PeripheralVision®  can start a web
browser but does not come with a browser application.

Before you first use this feature, it is necessary to set up the browser:

1 Click on the Tools menu, then select Options.

2 Click on the tab for the Configuration page.

3 Select the browser used on your PC (or use Browse to locate it).

4 Click on Apply, then click on OK.  The default web browser setup is now
complete.
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TELNET

You can use a TELNET utility to access different machines (i.e. from a
Novell network to a UNIX network) by following these instructions:

1 If an agent icon  has a T N icon superimposed on it, click on the right
mouse button to see the popup menu shown below:

2   Select Telnet to access the TELNET
window.

By default, PeripheralVision®  will automatically discover TELNET compatible
devices.  To switch off this auto-discover function:

1 Select Options from the Tools menu, then click on the Configure Page
tab.

2 Click off Automatically discover Telnet.

3 Click on Apply and then click OK.  The TELNET utility will now be
disabled unless you enable it again.

1 Select the agent by clicking on the right
mouse button.  The popup menu that
appears has an extra option, Browser,
as shown here:

2 Select the Browser button.

Agents with HTML abilities will be displayed on the map screen
superimposed with a Globe icon. These agents can be interrogated using
the web-browser, as follows:
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FTP Access

This feature launches File Transfer Protocol (FTP) access from within
PeripheralVision®.  To use this feature proceed as follows.

1 If an agent icon  has a FTP icon superimposed on it, click on the right
mouse button to see the popup menu shown below:

2   Select Launch FTP to access the FTP
window.

By default, PeripheralVision®  will automatically discover FTP compatible
devices.  To switch off this auto-discover function:

1 Select Options from the Tools menu, then click on the Configure Page
tab.

2 Click off Automatically discover FTP.

3 Click on Apply and then click OK.  The FTP search will now be disabled
unless you enable it again.
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Managing the Discovered Devices

Chapter 2 outlined the procedures for using PeripheralVision® to discover
Local and Wide Area Networks.  This chapter explains how to interrogate
and remotely manage the agents you have found.

To interrogate an agent, double click on the icon
representing the agent to be viewed and managed
(for example, this Sales Printer icon):

Alternatively, by clicking on the icon with the
right mouse button and selecting Properties
from the popup menu, the same result can be
achieved.

Agent Property Pages

After you follow the steps described above, the agent's property pages will
appear on your screen.  Arrows in the top right corner of each page allow
you to scroll through the different page titles.  Clicking on a title brings up
the corresponding page.

Pages will display agent information ranging from product name and model
to comprehensive configuration and network setup data, including
parameters for Novell NetWare, TCP/IP, and details of the hardware interface
that has been discovered.  Explore the pages to see the full extent of the
information and functionality available.

Chapter 3
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If the agent you are interrogating is a printer, the series of icons on the left
side of each page give details of the printer’s status (their meanings are
detailed below).  An icon’s appearance changes according to the type of
error occurring.  For example, in the image below, icon number 2 is red
because the printer has run out of paper.  Once the paper tray is filled, the
icon will change green
.

1. Traffic Lights:  Red - not functioning:  Amber - minor
problem: Green - ready and all clear

2. Out of paper
3. Paper jam
4. Low toner
5. Unidentified problem
6. Cover Open
7. Service error:  engineer required
8. Printer warming up
9. Printing

1

2

3

4

5

6

7

8

9

An example of a property page is shown opposite.  This is the  Names Page
(the default page).  It shows a picture of the agent (a Kyocera printer), with
its model name and beneath this the status box which displays error
messages for the Front Panel (in this example, the printer is out of paper).
These features appear on all pages, though the information will change as
the status of the agent changes.  Beneath the status box is the Refresh
Status button,  which can be selected for instant page status updating.

On the right side of the page is the information that is specific to the Names
Page.  Information contained here will be different for every page.  If you
make any changes to a Page, select the Apply button to save changes
without exiting the properties pages,  or press the OK button to save
changes and exit.

Following are examples of commonly available pages. The exact page
combination will vary depending on the agent’s type and make.

Status Symbols
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Names Page

Hardware Type:  The type of printserver hardware is displayed in this field;
select a new hardware type from the drop down list.

Icon Title: The agent icon title can be changed here.

Host Name: The name from the DNS is entered here.

Description: Any additional information can be entered here including
printer location, department, etc.

Present: This field refers to protocols and services found on the device.
These can include: SNMP, NPMP, IPS, FTP, Telnet or http (this information
can also be found in the Status bar of the Map Screen when you hold the
cursor over a device icon).

Below the Present field is textual information on the last time
PeripheralVision® contacted this device for a status update.
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Address Page

Network Card(s) Details: This option displays the agent’s IP address, IP
subnet mask and hardware address.  Click on Edit Details to change this
data or click Remove Details to delete it.

Add Card
If you select the Add Card button the following dialog box will be displayed:

When PeripheralVision® discovers devices on a network it will attempt to
interrogate the devices to determine the number of network cards installed
and their IP address(es) and hardware address(es).  However, occasionally
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this information will not be fully available via the network.  It may be difficult
to obtain the hardware address or find information about second and third
address cards.  The Add Card option allows you to edit the database
manually in the Edit Card Details dialog box.  If, for example, you know a
device has multiple network cards, but PeripheralVision® discovers only
one card, you can correct the information here.

NPMP™ General Page

NPMP™ Device Properties

NPMP™ properties can exist for printers, printservers, routers, and even
hubs.

General Name: This is the general printserver name used for DEC LAT and
LANManager systems.

Track Name: This option allows the general printserver name to be linked
to the Novell NetWare and Apple printserver names (as they can be
different).  If the box is selected, the NetWare and Apple names will
automatically update to the General Name.

Node Address: This is the Ethernet/Mac address of the printserver.
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NPMP™ NetWare Page

Serial Number: The printserver has a unique serial number which appears
in this field.

Firmware Version: The printserver's firmware level is displayed here.

Hardware Type: The printserver’s hardware type, e.g. Ethernet Inline, will
be displayed in this field

Busy Timeout: When the printer is busy, set the time (in seconds) before
printer busy signal notifies that the printer is offline.

Sharer Timeout: If the sharer port is inactive, printserver will switch to the
network port (where applicable) after the Sharer Timeout period has passed.

Output: Either serial or parallel (default) printer ports can be selected for
external boxes.  If neither is selected, this option is greyed out.

Baud Rate: The serial port baud rate (input or output) can be adjusted here,
if applicable.
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NetWare Name: This is the current Novell printserver name which can be
replaced by any name up to 48 characters, and will be used to update the
printserver.

Track Name: This option links the Novell NetWare name with the general
name (NPMP™ Name Page) and Apple printserver name (NPMP AppleTalk
Page).

Fileserver Restriction: This limits to one the number of fileservers that the
printserver can log on to  - useful if there are more than fifty fileservers.

IPX Network/Node Number: For information only.

Operating Mode:

Auto: Auto switches between printserver mode and remote
printserver mode when a printserver of the same name is already
present.

Printserver: Printserver only.

Remote: Powers up as remote printer only.

Fileserver Scan:

Scan: This enables/disables a regular search of fileserver binderies
for the presence of the printserver, allowing automatic log on as
soon as a change is made.

Interval: This sets an interval in minutes for fileserver scans.

Hunting:

Hunt: When on, finds next free printer if specified remote printer
number is not available.  When off, only logs onto specified printer
number.

Number: This is an IPX address a printer can be logged on to.
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NPMP™ NDS Context Page

This page will appear for printservers that are NPMP™ compliant and
carrying the NetWare NDS packet (NDS is a component of NetWare 4.x).  It
can be used to give the printserver a Valid NetWare NDS Context.

NetWare Version: Select the version of Novell NetWare you are currently
using.

NDS Context String: This field is activated only if NetWare 4.x (NDS) is
selected for NetWare Version (above).

Fileserver Restrictions: This facility will only be available when NetWare
3.x (Bindery) option is selected.  Use the Add and Remove buttons to enter
any fileserver restrictions.
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NPMP™ AppleTalk Page

Printserver name: The Apple printserver name shown here may be different
from the Novell and General printserver name (for more information and an
explanation of the Track Names check box, see the NPMP™ General Page).

Active Zone: This field shows the specific zone that the printserver operates
in.

AppleTalk Entity Types: The entity types Laserwriter and ITC Responder
are fixed entities and appear by default. The Laser Shared entity can be
added for Apple share printserver support.
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NPMP™ TCP/IP Page

IP Address: Enter a new IP Address in this field.

IP Subnet Mask: This option allows you to set the Interface's subnet mask
to match that of the network it is located in (this is particularly important if
the 'local' part of the mask is not 0).

Auto IP Address: When this facility is selected, you can automatically
change the IP Address utilising the Ping and arp facility in MS-DOS..

DHCP: When the DHCP check box is selected, information on this page
cannot be altered.  When this option is deselected, TCP/IP facilities are
available.

SNMP Pages

Additional pages with increased management control can be accessed if
the device has embedded SNMP attributes.  SNMP offers advanced
functionality, including: selection/deselection of the printer's on and off
line status, paper tray selection, and access to control panel status
information.   PeripheralVision® will automatically detect the device's installed
SNMP functionality and will present the additional information.
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The following pictures are examples of supplementary pages.  In this first
example, the SNMP attributes of the previously discovered Kyocera printer
result in three extra pages (the page types and the configuration abilities
offered will vary with the make of the printer).

Front Panel Page

This page displays the exact information found on the front panel of the
printer, enabling you to remotely monitor and operate the front panel from
your workstation.  For this Kyocera printer there are complete status details
of the machine's functionality.  It can be seen that the printer’s status is
Ready,  it is set on the Optional port with a resolution of 600 dpi for A4
paper, and it will print 1 copy.

The buttons at the top of the page enable you to choose the language
used in the status window.

The warning lights for problems including paper out, toner out, paper
misfeed, cover open etc. are displayed.  There are also warning lights for
more serious problems requiring attention from maintenance personnel.

You can put the printer in on line mode from this page by clicking on the On
Line button.
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Resolution: This option allows you to adjust the DPI (Dots Per Inch) density
of the printer resolution.

Total Memory and Available Memory: Status data displays automatically.

KIR and Ecoprint: Use these options to alter the density of the print.

Device Page

This page allows you to change Paper Trays and select the number of
Copies to be printed.

Paper Page
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Front Panel Page

The page type and functionality will vary according to the manufacturer of
the agent and the type of device discovered.  A selection of  SNMP pages
(shown below) from a discovered printer of a different make (in this case a
Canon) illustrates the similarities and differences between printers.  The
Canon has an additional page and the detailing is different, but the operation
and concepts are essentially the same.

Printer Page

This page allows you to change the Toner Density.
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Device Page

This page lists the Firmware modules available to the printer.

This printer also has a Paper Location Page which allows you to select
Paper Tray options.

Other Types of Agents

Chapter 3 has concentrated on describing only those pages associated
with discovered printers.  In addition to printers, PeripheralVision® can
discover all devices connected to a network, from PCs and hubs to routers
and other network peripherals.  The type of pages encountered for each
agent will vary considerably.  The best way to appreciate the scope of
PeripheralVision® is to explore the agents on the PeripheralVision® map
screen for yourself.

As an example, following is the Managed Hub page for a hub selected from
a PeripheralVision® map.

The information supplied lets you monitor the status of the hub.  For example,
in the bottom right corner of the page is the Hub Information option.  Using
the Test and Reset buttons, you can run a test to determine if the hub is
working correctly.
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Managed Hub Page

The following example is a page from a Ringdale ISDN OverLAN Router:

ISDN Setup Page

This page lets you to set ISDN phone numbers.  Additional pages allow
viewing and configuration of other aspects of the router.

Selecting the Launch Overlan Commander tab at the top of the page opens
the OverLAN Commander router management program. This program gives
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access to comprehensive and sophisticated monitoring and configuration
procedures for the router  (clicking the right mouse button on the router on
the map page and selecting Launch Overlan Commander is another quick
way to access the program).

Important Note: It is strongly recommended that you set passwords for
accessing all router pages in PeripheralVision® because of the sensitive
nature of the information that can be configured.

The Ringdale ISDN OverLAN Router has a Password property page to
enable you to set the password.

PlotPro Access

PlotPro is a program allowing print jobs to be sent directly to plotters with
a high level of control over the job’s configuration.  It is ideal for printing
sophisticated graphics etc.  You can access the PlotPro program directly
from JRL and Ringdale plotter property pages discovered in
PeripheralVision®.   The access procedures are similar to those described
above for the OverLAN Commander.
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Agent Monitoring Facilities

Chapter 4

PeripheralVision® has sound, email and logging facilities which enable you
to set up a comprehensive monitoring system for your network.  To access
the agent monitoring facilities:

1 Right-click on an agent icon on the map screen.

2 From the popup menu, select Monitor Agent.  This will bring up the
Monitor Agent screen.

3 Click on the Status Logging tab to see the following page:
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The Status Logging page allows you to configure the logging for the
selected agent.  The log file you create will keep a record of the status of the
agent.

States Available for Logging: Select a check box in the list to enable or
disable logging performed by the selected agent when a  state change
occurs.

View Log File: Selecting this button allows you to instantly view the log
file.  The log file window will open, displaying the record of the agent’s
function statuses that you have chosen to monitor.

Setup Logs: Select this button to configure universal log file details.

Log Now Setup: In the Log Now Setup frame, you can choose whether
logging will occur for All states or for Monitored states only.  Once a choice
is made, select the Log Agent’s Details Now button for instant logging.

Agent Monitoring: Sounds

Note: To utilize the sound facilities it is necessary to have a sound card
installed on your PC.

PeripheralVision® comes with a full compliment of default sound settings.
The Sounds page gives you the option of overriding the sound defaults
and setting up your own customized sounds.

Note: Details of further sound configuration facilities can be found in the
section Setup Sounds Page later in the chapter.

Clicking on the Sounds tab in the same Monitor Agent  screen will bring up
the Sounds page shown on the next page, providing you have a sound
card installed.
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States Available for Audio Alert: You can enable/disable the sounds made
by the device when a state change occurs by checking the boxes found in
this list.

Setup Sounds: Click this button to configure universal sound settings.

Configure Sound Attached to this Agent: To set a sound of your own
choice to this particular agent:

1 Click on the Browse button.  The file path shown in the Path field
represents the currently selected wave file.

2 Scroll through file paths list to locate a new wave  (.wav) file.

3 To test the sound before configuration is complete, select the Test Sound
button.

4 Once a sound is chosen, check the Set sound as default for new agents
box to have this sound automatically assigned to all new devices.
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Agent Monitoring: Email

Clicking on the Email tab in the same Monitor Agent  screen will bring up
the following Email page:

Note: Before using the email facilities, you must have Microsoft Exchange
or Outlook installed.  PeripheralVision® automatically connects to the email
service when it is started.

Agent States: This list shows the various states existing for a particular
agent.

Send Email To: The email recipient groups which you configure in Setup
Groups (see below) are listed here.  To have email sent to a group, check the
box next to its name.

Setup Groups: Select this option to setup and configure groups of email
recipients.  The group names will appear  listed under Send Email to on the
Email page.
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PeripheralVision® Graph Wizard

PeripheralVision® has the ability to create Page Count Graphs to enable
you to monitor the number of pages printed by each of your network printers.

Note: To use this facility it is first  necessary to create a Page Count Status
log file which will provide the information for the graph (for details on how
to do this see the start of the chapter).

To create a page count graph:

1 Select Graphs from the View menu at the top of the map screen.  This
will launch the Graph Wizard.

2 Click Next, then Next again.  In the displayed dialog box enter the path
to the log file to be used for the graph and click the Add button, or use
the Browse button to find the file and click on Open.  The file will be
added to the list in the bottom half of the box.  You can enter as many
files as you require.

3 Click on the required file in the list to highlight it and click on Next.  The
following dialog box will be displayed:
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4 In the left hand box are listed the agents available on the log file.  Select
the agents you want to appear in your graph and click on the Add
button.  Your selection/s will appear in the right hand Agents to Graph
box.

5 Click on the Finish button and OK the following message box.  The
graph will be displayed.  An example is shown below, with the page
count history of 3 printers:

At the top of the Graph Viewer screen is a menu bar which gives access to
the following options:

File
Save As: Use this option to save your graph as a windows bitmap.

Print: Use this option to print out your graph.

Edit
Copy: Using this option, the graph can be copied and pasted into other
applications
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Graph
Axis and Scale Settings: Selecting this option will display the following
dialog box:

This option enables you to tailor the graph to your requirements by changing
the default scale settings to include only the data you would like in the
Graph.

Configure Graph Limits
Graph Start Date\Time: Enter here the date you want the graph to start
from.
Graph End Date\Time: Enter here the date you want the graph to end on.

Configure Graph Ticks For The X Axis
This enables you to set the configuration of the Time axis to your
requirements.
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Options Property Pages

To access additional monitoring facilities:

1 Click on an agent on the map screen to select it.

2 Click on Options from the Tools menu at the top of the map screen.  You
will see a dialog box titled Options Properties with seven tab options.

3 Clicking on each tab will access a different property page enabling you
to view and configure the information.  The function of each property
page is explained below.

Configuration Page

Configure Discovery Settings: The first three of these settings allow you
to designate which of the three available options - Telnet, FTP or NPMP -
you want PeripheralVision® to automatically discover.  They can be set in
any combination you require.
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Enable Extended Discovery:  This fourth option can be useful if you
are trying to discover an entire network.  When this option is selected,
for each new agent with SNMP that PeripheralVision® discovers,
that agent’s ARP Table is interrogated to find further addresses to
discover.  This will often result in extra agents being displayed on
the Map Screen, including devices that were not actually requested
in the original search criteria.

Language Settings: This drop-down list allows you to change the language
used in PeripheralVision®.  Select from English, French, German, Spanish,
Italian, or Japanese.

Other Settings:

Use Sounds: Select this option if you want a sound to alert you
when error conditions occur.

Connect to Mail Server: PeripheralVision® automatically connects
to the email service when it is started.  To deselect this option click
on the tick box to remove the tick.  See the Options Property page
Setup Email Groups for more information on configuring this
option.

Browser: Choose the browser you want to use, for example Netscape
Navigator or Microsoft Internet Explorer, from the drop-down list.  You can
manually change the file path for the type of browser you have selected by
typing in the datafield.  The Browse button allows you to manually find the
web browser that is installed on the machine.

Ping Release Rate: This sliding bar controls the release speed of the
discovery probes.  If, for example, you have a slow modem, you should
move this bar closer to the “Less” end of the scale, otherwise most discovery
packets will be discarded.  Due to the nature of ICMP and UDP packets,
when a network gets busy, these are discarded first.  Therefore, if you are
trying to discover over a slow connection, you will miss most of the replies
coming back.  Moving the bar closer to “Less” allows questions to be
asked more slowly, therefore giving PeripheralVision® a greater chance for
successful discovery.
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Security: Selecting this button will display the Security dialog box:

PeripheralVision® has a three level security system that is expandable and
fully configurable.  An administrator can use the Security dialog box to
create and customise new security levels and configure the access rights
of existing levels.  Some users, for example, could be allowed to view a map
but not save any devices to it.  The three security levels are User, Operator
and Administrator.

The Security dialog box contains two menus - User and Options - and a list
view, as shown above.  The list view shows the Username, Access Type
(access rights to the program) and a Description field for all users in the
database.  Each active user has a tick next to it.  The user currently logged
on has a star next to their name.  The list view can be sorted into either
ascending or descending alphabetical order by clicking on the column
headers.

To set access rights:

1 Click on the User menu.

2 Select the New User option.  The dialog box shown on the next page will
appear.



51

The User Properties dialog box allows you to add security access and
perform management functions.

Access Level: Choose an Access Level from the drop-down list. If you are
creating the first user, access level must be administrator.  Initially, only
administrators have access to Security options.  You cannot configure
any security options until you have created an administrator.

Username and Password: Use these fields to add new user names and their
passwords at the selected Access Level.  Each user will need to enter their
own password every time they want to access PeripheralVision®.  In the
Description field you will see a description of the user’s access rights.

If you want to prompt the user to change their password at first login,
select the Change Password at Startup box.

Select the Disable Users Access box to disable this users access.

To go back to the Security dialog box, choose OK.  You will see the user
names you have entered are now listed on the page.
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Other facilities under the User drop-down menu enable you to delete or
rename each user.

User Logon
If security has been configured for your copy of PeripheralVision®, you will
need to log on when you start the application.  If the program is already
running and another user is logged on, you can log on by choosing User
Logon from the User Access menu on the PeripheralVision® main screen.
The PeripheralVision® Security dialog box will appear for you to enter
your password.

User Logoff
When you exit the program you are automatically logged off.  If you want
to leave the program up and running, select User Logoff from the User
Access menu on the PeripheralVision® main screen.  You will be logged off
immediately; no dialog box will appear.  Choosing this logoff method causes
all operations to be restricted until a user logs on.

Security access levels can be further expanded and configured by clicking
on the Options menu in the Security dialog box and selecting the Configure
Access Levels menu option.  The following dialog box will appear:
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The Configure User Level Access dialog box enables you to define access
rights for the various levels and create new access levels if required.

Level Access Rights: This section of the dialog box shows existing Access
Levels and their corresponding Access Rights.  The current Access Level
appears in the drop-down list.  The selected check boxes indicate which
options can be accessed by users from this level.  Scroll through the drop-
down list to view access rights available for the various Access Levels.

Select the level you want to configure from the drop down list.  The default
check boxes will be automatically selected to show the level’s current access
rights.  Select and/or deselect the appropriate check boxes for the user
level.  When user configuration is complete, click on Apply or OK or click
on Cancel to discard any changes.

Create New Access Level: To create a new Access Level:

1 Type a unique name in the Access Level Name text box.

2 Type a brief description of the new level in the Description box, which is
automatically activated.

3 Select the Create New Level button to insert and highlight the new level
in the drop-down list.

4 The default check boxes will be automatically selected. Select and/or
deselect as required.

5 Click on the Apply button for immediate application of  all chosen settings.
Click on OK to return to the Security dialog box.

Also under the Options drop-down menu, you can select Remove All
Security if you do not require user access rights any longer.

This option will completely destroy all security configured for the
application.  When all security is removed, PeripheralVision® will be fully
accessible by any user.
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Configure Machine Icons Displayed: This table displays the icons that
can appear over a device on the Map Screen and explains the purpose of
each.  Choose which icons to activate by clicking in the check box next to
each icon.

View IP Addresses: Selecting this check box will allow you to view an IP
address instead of a machine name for each icon title.

Configure Machine Display Page
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Setup Monitor Logging Page

Path to Log File: This is the directory or file path to be used by
PeripheralVision® for maintaining a log file for agent monitoring.  You can
change this file path by either retyping the path in the data field or by
selecting the Browse button.

Rate of Page Count Logging: This is the frequency at which the log file will
be updated.  More frequent logins help to ensure that the log is up-to-date.

Maximum Log File Size: This is the maximum space allowed for the log file.
Select the View Log File button to view the Page Count log file from Windows
Notepad.  If the log file reaches the maximum size, it is automatically placed
in a backup file with the same file name but ending with _backup.xxx, where
xxx represents the version number of the log file with the highest number
being most recent.  The backup files will be the same size as the maximum
size that was allowed when they were created.
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IPS™ Configuration Page

Log Now Setup: This option allows you to choose whether you want a log
file setup for all discovered agents or only agents with states for which
monitor logging is enabled.  If you select the Log Details For Selected
Agents Now button, you will force immediate logging to occur only for the
agents for which monitoring is configured.

Setup Monitor Logging for All Agents: If you select this button, monitor
logging will be setup for all devices.  This option can save you time when
you are setting up several devices for the same type of monitoring.

This page can only be accessed if IPS™ is installed on your PC and it is
set to communicate with PeripheralVision®.  The Ringdale Internet Printing
System™ (IPS™) is software that enables you to print from any application
on Windows 95/98 or Windows NT 4 to any network connected printer that
has a valid IP address.
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Path to Notification File: Use this directory or file path to maintain a
notification file for IPS.  This will create a record of detailed information of
all print jobs sent from your PC using IPS™.  Change the path by retyping
its name or by selecting the Browse button.

View File
Select the View File button to view the contents of the file listed in the Path
to Notification File box.

Associate External Applications Page

This option allows you to associate specific external applications with
chosen machine types and then launch the application by right clicking on
a device.  Initially, you will need to select a machine or group of machines
and then associate application(s) with these.  Any one machine can have
up to 10 external applications associated with it.
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The Associate External Applications Process
To begin the association process:

1 Select specific machines by highlighting their names in the Machines
List or check Apply To All Machines (you can redo your choices by
selecting the Reset Selections button).

2 To associate or disassociate the chosen machines with applications
shown in the Common Machine Applications list, highlight an application
from the list

3 Press one of the following three buttons:

Associate Button: Selecting this button will associate the type of
device with the selected application, creating a link between the
two.

Disassociate Button: Selecting this button will disassociate the type
of device from the selected application, removing a link between the
two.

Remove All Associations Button: Selecting this button causes a
global disassociation to occur.

4 Once machines and applications have been associated, press Apply for
the association to be enabled.

5 (Optional) Select the Edit Applications List button to display the Locate
Application to Associate dialog box that is shown on the next page.

You can use this dialog box to configure a list of applications associated
with specific machine types.  Applications can be selected for addition
to the list using the Browse button, Browse for New Application field,
or the drag-and-drop method.  Applications can also be deleted or
edited.  After association is complete, you will be able to launch the
applications by right clicking on an agent or by choosing External
Applications from the Tools menu.
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Note: The two default applications installed with PeripheralVision® are
OVERCOM and PLOTPRO.  You cannot edit or delete these applications
while they appear in the Current External Application List in this dialog
box.

The dialog box operates as follows:

You Can Drag and Drop File in Here ! Box:  Click on a file (for example from
your desktop) hold down the mouse, and drag it to the You Can Drag and
Drop File in Here ! box.  The file is automatically added to the Current
External Application list.

Application Label Field:  The Application Label field contains either the
file name of the application or the name you type in the Label field of the
Label Application dialog box.  An application’s Label will display on any
menus that refer to the application.

Location:  This is the drive and file path for the application shown in the
Application Label field.



60

Use Application Name as Label:  When this is selected, the file name of an
application added or edited automatically appears in the Application Label
field.  If the box is not selected, the name you type in the Label field of the
Label Application dialog box appears.

Browse for New Application:  In this field, type a file path for the application
you want to add and/or edit.

Browse Button:  Select the Browse button to browse the Windows
directories and folders.

Delete Application Button:  Select an application from the Application
Label field and then click on Delete Application to remove it from the
Current External Application List.  You cannot edit or delete OVERCOM
and PLOTPRO while they appear in the Current External Application
List.

Arguments:  If you add a new application to the list without selecting the
Use Application Name As Label check box, you can assign an argument to
the application in the Label Application dialog box.  Arguments are specific
to different programs.  For example, when OVERCOM is launched, it takes
an IP address as an argument.  In this case, because each agent has a
different IP address, you can type the word IPADDRESS as the argument.
When you launch the application from an agent it will execute the application
as, for example, C:\overcom\overcom.exe 194.217.180.180, where
194.217.180.180 is the IP Address of the agent.

Other applications use words or series of  keystrokes as arguments, for
example: /s/t/y(slashes).  For this type of application, enter the argument
exactly as it appears.  Should any application take both an IP address and
slashes, replace the actual IP address with the word IPADDRESS.

If the application is launched from the External Applications option in the
Tools menu, there is no IP address, and this part of the argument is ignored.
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Edit Application Button:  To edit an application in the Locate Application to
Associate dialog box:

1 Click on an application in the Application Label field.

2 Click on the Edit Application button.  The Label Application dialog box
will appear as shown below:

3 Edit the Label and Arguments fields as you require.  Any changes made
will appear in the Locate Application to Associate dialog box (you can
click on the Browse button to locate additional files for editing).

4 Click on OK to save changes, or click on Cancel to exit the dialog box
without saving changes.
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Setup Email Groups Page

Email Groups: This option allows you to define groups of email recipients
and send group messages.  Select which printer states you want alerts for
(for example ‘out of paper’) and then set PeripheralVision® to email
notification of the problem as soon as it occurs.  Before configuring the
PeripheralVision® email group options, you must have installed either
Microsoft Exchange or Outlook.  In addition, you must log on to your email
service under Tools menu > Options > Configuration Page > Other Settings
>Connect to Mail Server.

Add Group: When you click on the Add Group button, you will see a dialog
box that allows you to add new groups to your list of group email recipients.
You must assign a unique name to each group before associating names,
addresses, and group messages with it.  The group’s name will appear in
the Email Groups list.

Remove Group: When you click on the Remove Group button, you will see
a dialog box that allows you to remove existing groups from your list of
group email recipients.
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Setup Sounds Page

Edit Group Message: Selecting this button allows you to edit the messages
you have previously set up for specific groups listed in the Email Groups:
list.

Name and Email Address: This list shows the names and email addresses
of the individual members belonging to your email groups.  When you
select a group name from the Email Groups list, the member names and
addresses will automatically appear here.

Add Address: Select this button to add a new address to the group currently
selected in the Email Groups: list.

Remove Address: Select this button to remove an existing address from the
group currently selected in the Email Groups: list.

Setup Email Alerts for All Agents: This button allows you to setup alerts
for all agents (devices) that indicate when email has been sent or received.
If you press this button you will see a dialog box prompting you for the
necessary data to setup email alerts.
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Configure Agents Status Sounds: You can associate specific error
conditions with sound files (first, check the Use Sounds option under Other
Settings on the Configuration page of Options Properties).  The error
condition shown in the Status field is associated with the sound file in the
Path field.

Test Sound: Test a sound by pressing this button.

Browse:  Use this button to find a sound file of your choice.  After
associating an error condition with a sound, click on the Set these sounds
as defaults for new maps box to have the association apply to all new maps.

Setup Audio Alerts for All Agents
Select this button if you want to setup audio alerts for all agents discovered
by PeripheralVision®.
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Creating and Editing Your Network Map

Having discovered all agents you can now create a network map. A set of
icons on the tool bar at the top of your screen will enable you to design
your screen layout and explore the cabling facilities.

New Agent
The New Agent toolbar button allows you to add agents that have
not been autodiscovered.  When this option is selected, the cursor
will change to a cross cursor for positioning.  A single click will
locate the agent on the map and display an empty property page
(shown below) for specifying the agent’s details.

Operating PeripheralVision®: The Network Map

The type of machine can be selected from the Hardware Type drop down
box.  Clicking on the tabs at the top of the page allows you to enter both
Names and Addresses for the machine.

Chapter 5
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AutoCable
Once all network agents have been discovered, the AutoCable
option allows you to automatically cable up the discovered devices.
When you click on the AutoCable button the program connects the
agent icons via colour coded lines.  Machines that are on the same
IP sub-network are tied together and the cables are labelled
accordingly.   Below is an example of an autocabled network map.

New Cable
This facility enables you to organize your autocabled map and add
new cables by following these steps:

1 Click on the New Cable button to open a dialog box  for choosing
the cable colour and thickness (see next page).

2 Once colour and thickness have been set, press OK.  The cursor
changes to a cross cursor.

3 To choose a starting point for the cable, click the left mouse
button on an appropriate point on the map screen.

4 Each subsequent click of the mouse will designate a corner of
the cable.

5 Double click to secure the cable end point.
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New Cable Dialogue Box

You can use these PeripheralVision® features to design a map of  your
network, as shown in the example below.

1 Click on and drag each agent icon to move it to a specific position on the
network map screen.

2 Use the cabling functions to construct the network.
3 To affix each agent icon to the appropriate cable, right click on the agent.

From the displayed menu, select Attach Agent.
4 To detach, follow the same procedure, but select Detach Agent.
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Additional Editorial Facilities

Delete Agent: Select an agent and press Delete or right click on an agent
and from the popup menu, select Delete Agent.

Cable Popup Menu
Right clicking the mouse on a cable will
bring up this menu:

You can use the popup menu options to delete cables and nodes as required.
Select  Hide Network to reduce the network that includes the selected
cable to an icon on the map screen.  This can be useful when dealing with
large networks.

Print Preview: Select this from the File menu to view your newly designed
map.  You can choose to print your map in either Landscape or Portrait
format.

Additional Toolbar Options

Sort Current Agents
This option sorts agents displayed on the PeripheralVision® map
into IP address code order from left-to-right and top-to-bottom.  All
current cabling will be recabled and the colour of cables may change.

New Map Screen
This tool bar button resets the map screen, deleting and clearing the
existing screen.

Save
Once you have discovered your network environment, selecting
this toolbar option allows you to save the map to a specified drive.
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Open
After you have saved the information to a designated drive and
closed your map down, select this option to access the map again.

Print
Choose this option to print the discovered map displayed on the
screen.

Set Refresh Rate
Select this option to adjust the rate at which PeripheralVision®

updates the status of currently discovered agents.  The following
box will appear, where you can change the Refresh Rate.  You can
also set the number of times PeripheralVision® will probe an agent
before declaring it “dead”.  If you don’t want the currently discovered
agents to be updated click off the Refresh Agents box.

Search Returns
After using the Ping Locater, NPMP™ Locator, or Search DNS
functions, select this button to see a window showing the search
results.  For example, after a multiple Ping, the Search Returns
window will display a list of the pinged IP addresses.  For each Ping,
you will be told whether it was successful and whether the device
was located.
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Refresh All Agents
Click on this button to refresh the status of all the discovered agents
on the map.

Send E-Mail
Enables you to call a Message box from within PeripheralVision®

without the need to change windows (this facility can be turned on
and off by selecting Options from the Tools menu at the top of the
map screen and selecting the Configuration property page.  Under
Other Settings select Connect to Mailserver choosing on/off as
required).

Help Topics
This toolbar button provides instant access to help pages and
registration information.

Toolbar Settings
To configure the toolbar settings:

1 From the View menu at the top of the map screen, click on Toolbar.

2 Click on Small Icons or Large Icons or No Toolbar.  The last option
removes the toolbar from the screen completely (the default setting is
Small Icon).
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SNMP Tree Walker Function

Chapter 6

The SNMP Tree Walker is a program that allows you to interrogate the MIB
(Management Information Base) tables of a discovered agent (or an agent
with an IP address) for more comprehensive SNMP information than is
displayed within the PeripheralVision® property pages.

To Use SNMP Tree Walker:

1 To open the program, click on the SNMP Tree Walker toolbar
 button at the top of the PeripheralVision® map screen:

or choose the SNMP Tree Walker option from the Tools menu.  The
SNMPTREE dialog box will appear on your screen (see the following
page for a picture of the dialog box).

2 Optional: If you select a discovered agent in PeripheralVision® and then
open  SNMP Tree Walker, the agent’s IP address is passed to the program
and appears in the IP Address box.  However, if the box is empty, you
must type in an address.

3 Click on the Test button. If the IP address is SNMP configured, the
Found and SNMP lights will flash and the SNMP tree will load into the
large box.  If there is no response, it is not SNMP configured.

The Device at this Address box will show details of the agent you are
interrogating.  The SNMP Object ID box will show the SNMP system
description available from most SNMP capable agents.
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4 Optional: Occasionally, the first test will fail.  Click on the Test button
two or three times, if necessary.

Note: At the top right of the window is a box marked Community which
usually contains the word public, the default community name.   If an SNMP
capable agent flashes as Found (yellow light) but does not acknowledge
SNMP (no green light) it may be set to use a different community name.
Locate the community name, enter it, and run a test again (if the SNMP tree
program was called from another program, an appropriate community name
may automatically appear).

Note: SNMP has been implemented by many manufacturers.  Although all
manufacturers have been working from the same RFCs, there are differences
in interpretation.  SNMP works with almost every application you are able
to connect to, but occasionally you will find odd agents that the program
cannot understand.

The results of a successful test are shown on the screen below:
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Walking the Tree

The tree display in the SNMPTREE dialog box is manipulated in the same
way as the tree display in Windows Explorer.  Branches can be opened and
closed by clicking on the plus (+ ) and minus (-) signs.  A particular item can
be selected by clicking on it.

If a selected item represents an object which has a value, the value will be
fetched and displayed in the Value field.  If the item does not represent a
value but is part of the tree structure, descriptive information is displayed
in the fields on the right side of the screen under Selected Item.

Selected Item Information:

Name: This is the current object’s name (from a MIB and not the agent
being tested).

Type: The object type will be in upper case letters if it was obtained from the
tree information; it will change to lower case if obtained from the actual
value read from an agent.

Text/Hex: Clicking this button switches the Value display from text to
Hexadecimal display.  Some retrieved items are marked as being octets (i.e.
bytes); these are often text strings and are displayed as such.  Some octets
represent quantities such as machine addresses.  In these cases, the
numerical value of each byte displayed as two hexadecimal digits is more
useful.

Value: This is the value retrieved for the current object.  The display is
scrollable to allow for very large values.  It can be switched from text to hex
type display as needed.

Result of Last Command: This field holds a message describing the progress
of the most recent command.  The message is usually either OK or an error
statement explaining why a requested command failed.

SNMP Object ID: When an object is identified in the tree, its OID will be
displayed in this field.  An OID can also be directly entered into this box.



74

OIDs
Individual objects are identified in the SNMP world by a unique code, an
Object Identifier - often abbreviated to an OID.  An OID consists of a series
of positive numbers separated by dots.  OIDs are organised as a vast tree.
Some branches are defined by the standards organisation and used by
many people.  Other sub-branches are allocated to a particular manufacturer
or type of device and defined by the interested parties.

To make full use of an agent’s SNMP information, it is desirable to know
what each value represents, including its range, name, etc.  This information
is normally supplied as a  MIB, a  “human-readable” document that follows
a standard format.  A MIB lists the OIDs in a collection of sub-branches
and details their relationships and use.  The MIB is machine-readable and
structured so that information needed to access particular values can be
easily extracted.

Often the MIB is not available and you may not know the type, manufacturer,
or model of the device you are connected to.  The tree program will extract
as much information as possible by interrogating the device and build the
needed parts of the tree.  Individual values and tables may be examined.

To make full use of the SNMP information, fill out the tree structure which
contains the data you require.  Once the tree structure is filled out, you can
select any particular OID and fetch its value by pointing to it in the tree
display.

Information for the tree consists of a combination of data from two sources,
the data files derived from MIB documents, and the information stored in
the device being examined.  For example, the value of a selected OID could
be the activation of a printer’s paper tray.  By altering the figure in the Tree
Walker’s Value field, you could select or deselect that particular paper tray.
By clicking on the Set button, you could then send the data in the Tree
Walker’s Value field to the agent.  If the agent is configured to allow this, its
value will change accordingly. The Value window allows such values to be
edited and entered.
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Loading the Tree from an Agent.

Get: This command automatically fetches the value for the OID currently
selected in the tree.  Get is mainly used when looking at a value which
changes frequently.

Get Next: Clicking on this button (in the bottom right of the screen)  requests
the next value from the agent under test.  Once the agent has given you the
first OID, you can repeatedly click on Get Next to get a complete read out of
the agent’s OID values.  The program automatically adds any new OIDs it
receives to the tree.  Running through all OIDs associated with a particular
device will build a copy of the device's  SNMP tree segment.

Get Row: The value for an OID is often shown with an extra zero on the end.
The tree may show an OID as a table of values with a range of values on the
end, one for each value in the table.  Clicking on the Get Row button will call
the entire range of values to be fetched and displayed.

Get All: Clicking on the Get All button will repeatedly request the next
value until no further values are forthcoming.  This is useful when filling in
the details of an unknown device’s tree structure.  The button acts as both
a stop and start switch.  This is necessary because some devices may
contain a very large number of values which take too long to fetch.  The
auto repeat function stops when it reaches the end of the data, which is
signalled when no value is returned after a suitable amount of time, or when
an error is returned.

When quizzing a distant device, or when using a noisy connection, it may
be necessary to use Get All repeatedly to reach the end of the device's
data.   Errors and long delays caused by a noisy channel may convince the
program that the remote device has finished before it really has.
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Loading the Tree from Files
Data files are loaded by using the buttons in the bottom left corner of the
SNMPTREE dialog box, as follows:

1 Click on the Load Tree button.  The file selection screen will be displayed
on your screen.

2 Click on Open.  The default file name default.tre will be selected and
loaded.  Default.tre contains information on several basic branches used
by many SNMP devices and is supplied with the program.

3 Once the file has loaded, plus (+) signs appear next to tree entries.  Click
on these + signs to expand the branch and display details of the loaded
file.

4 If you wish to load a different set of information, enter the name and
path to a data file in the file selection screen.  Click on Open.

Note: If you want to merge file information to the existing tree display rather
than replacing it, click on the Add Tree button instead of the Load Tree
button before selecting the file.

Saving Tree Information

1 Click on the Save Tree button in the lower left corner of the SNMPTREE
dialog box.

2 At the prompt displayed, type a file name for saving the current tree
information.

Note: Save Branch also saves tree information, but only for those items
below and to the right of the currently selected item.



77

Product Authorisation and Licence Transfer

Chapter 7

PeripheralVision® software comes unlicensed for 30 days.  At the end of
this period the software protection system asserts itself and encrypts parts
of the program.  In order to reactivate the program and continue using the
full facilities of PeripheralVision®, you must obtain a Sitecode Licence.
Although you can use your CD to install PeripheralVision® on as many
machines as you wish, unless you obtain a licence for each machine, they
will cease to function fully after 30 days.

Product Authorisation

To obtain a  Sitecode Licence contact your supplier or the manufacturer
with your Sitecode.  This can be found by selecting Register Product from
the Help menu .  The Registration dialog box will appear as shown below:

The Site Code is shown at the top right of the dialog box.



78

If contacting Ringdale directly, please have your credit card information
ready for immediate registration.  Registration can be done over the phone,
by fax, by post (for numbers and addresses see the back cover of this
manual) or across the Internet.

Note: Two buttons on the registration page enable you to obtain your
licence from Ringdale across the Internet.  Select the Web Site button to
connect to the Software Authorisation page of the Ringdale web site, or
select the Email button to access the following form (before you can register
PeripheralVision® by email, you must be connected to your Mail Server -
see the section Configuration Page in Chapter 4):

Fill out the form and click on OK to send it to Ringdale as email.  You will
receive an email reply shortly.

Entering the Sitecode Licence
Once you have obtained the licence authorization key type it into the data
field labelled Authorization.  Then select the OK button.  Your copy of
PeripheralVision® will now be authorised.

The authorisation status will now be changed in the Current License
Information section.  The Level box should now say Full Version.
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Licence Transfer

The Licence Transfer feature allows you to transfer the licence from one
computer to another, or from one directory to another.

Important

It is safe to copy or rename the directory that PeripheralVision® is in, but be
careful to avoid destructive actions that may delete PeripheralVision® or its
surrounding files.  If a user needs to reformat or change a hard disk, care
must be taken with the software authorisation key.  It must be transferred to
a safe location by installing PeripheralVision® either on another machine or
on a separate directory on the same disk if only deleting that directory.

Use the methods described below to safely transfer the licence from an old
to a new copy of PeripheralVision®.

Two methods are described for moving a protected program.  These do not
actually copy the program from one directory to the other.  Instead, the
licence from one program is moved to a copy of the same program in a
different directory.

Direct Transfer - Windows 95/98

Direct Transfer is used to move a program from one local or networked
directory to another, as follows:

1 Copy the program into another directory

2 Open the copied software to indicate that a transfer is beginning.  When
trying to open the software you will see the message shown on the top
of the next page.
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3 After pressing Register Now you will be shown the Sitekey Registration
Page as displayed on the opening page of thischapter.

4 Click on the Move Licence button and you will be shown the following
window:

5 In the Path text box, type the directory path where the unlicensed version
of PeripheralVision® will be located, or use the Browse button to locate
it.

6 Press the OK button and the message Transfer Complete will be
displayed.

7 Click on the OK button to acknowledge this.

The copied program is now authorised and the original copy is unauthorised.
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4 Enter the path to your floppy disk drive.

Floppy Transfer - Windows 95/98

Floppy Transfer moves a licence from one computer to another using a
floppy disk.

This process involves transferring special Licence Imprint files.  To transfer
a licence from one computer to another, you must have:

1 A copy of the program already installed and authorised on one computer
(which shall be known as the source computer).

2 A copy of the program already installed but not authorised on another
computer (which shall be known as the target computer).

Assuming the transfer is from an already licensed source computer to an
unlicensed target computer via floppy disk, the process is as follows:

1 Start the program in the target computer.  The unauthorised 30 day
demo has expired window will be displayed if the demo has expired (the
program can be licenced before the demo expires if required).

2 Click on the Register Now button and you will be shown the Sitekey
Registration Page as displayed on the opening page of this chapter (or
access the page from the Help menu).

3 Click on  the Reg. Transfer button and the following window will appear:
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Use the Browse button to locate the directory of the program and click OK.
This will read the registration imprint and write a matching licence imprint
to the floppy.  It will also discontinue the licence at the source if there was
a single copy.  If there were multiple copies, it will decrement the licence at
the source by one.  A message saying Transfer Complete is then displayed,
indicating that the source program is unauthorised.

9 Take the floppy disk from the source computer and place it in the target
computer.

10 Start the program in the target computer.  Click on the Transfer In button
on the SiteKey Registration Page.  The window shown at the top of the
next page will appear.

5 Click on the OK button.  This function will put a registration impr in t
on a floppy disk and the message Registration Complete should appear.

6 Take the floppy disk out of the target computer and place it in the source
computer.

7 Start the program on the source computer.  From the Help menu at the
top of the map screen, select Register Product.  This will display the
Sitekey Registration Page again.

8 Next, click on the Transfer Out button which will display the following
window:
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11 In the Path text box, enter the path to the floppy disk.

12 Click on the OK button.  The message Transfer Complete should be
displayed.  The Sitekey Registration Page will change to show
Authorisation OK.

The licence has now been successfully transferred.  The source computer
is unlicensed and the target machine is licensed.

Direct Transfer - Windows NT

Transferring the licence with Windows NT software follows essentially the
same procedure as for Windows 95/98, but includes an extra step.  NT has
a CrypKey Licence Service that supervises its protection systems.  This
service must be informed that the licence is being moved.  Proceed as
follows to move the licence from one directory to another on the same
machine:

1 Copy all PeripheralVision® files to the new directory, or re-install
PeripheralVision® into the new directory.

2 From Start/Programs/PeripheralVision, select CrypKey Server for NT.

3 Click on the Add button and enter the new path to the licence, or use the
browse facility to locate the new directory.
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4 Click on the Open button.  You will see that the new location has been
added to the screen.  Exit the CrypKey window.

5 Open PeripheralVision® in the old (licensed) directory (use Windows
Explorer to locate and open the program as the shortcut will be pointing
to the new directory).  Follow the instructions as for Windows 95/98
Direct Transfer and transfer the licence to the new directory.

6 When the procedure is complete, manually delete the files in the old
directory using Windows Explorer.

Floppy Transfer - Windows NT

To transfer a license using a floppy disk for Windows NT, follow the
instructions under Floppy Transfer - Windows 95/98 but with this extra
step.  After Step 6:

From Start/Programs/PeripheralVision, select CrypKey Server for NT.

Click on the Add button and enter the new path for the licence (i.e. the
floppy drive - usually the A drive), or use the browse facility to find it.

Click on the Open button.  You will see that the new location has been
added to the screen.  Exit the CrypKey window and continue with the 95/98
instructions.

When you return to the target computer, it will be necessary to repeat this
procedure, this time entering the location of the program you are about to
move the licence to into the CrypKey Server for NT window.

Note: Because no special "mediatricks" are involved, you do not have to
use a floppy to transport these encrypted text files back and forth.  You can
use either your network or email to transfer a licence electronically around
the world.
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Menu Options

Appendix A

In addition to popup menus and tool bar buttons, PeripheralVision® also
has seven pull-down menus which are found at the top of the Map Screen.
Click on a menu title to see the options available for each menu.

Note: Some of the menu functions can also be accessed through the toolbar
buttons and are described in previous chapters.

File Menu Options

Here is an example of the pull-down File Menu.
An explanation of the options follows.

New: This option creates a new map screen.

Open: This option opens a previously saved map screen from disk.

Save: This option saves the current map screen to disk (PeripheralVision®

saves its map screens as *.mdb Microsoft Access database files).

Save As: This option saves the current map screen to disk under a new
filename that you specify.
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Summary Info: This option allows you to enter summary information about
the selected map.  Choosing this option opens the Summary Information
dialog box as shown below:

Page Setup: This allows you to see and manipulate an onscreen
representation of the printed page.  Selecting this option opens the dialog
box shown below:

The data fields for Name and
Description can contain any
data you decide to enter.
However, it is recommended
that the contents refer to the
networks and devices of the
map currently displayed.
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You can set Paper Size and Source,  paper Orientation, and Margins.
Selecting the Printer button allows you to review the default printer
information.

Print preview: This option displays an onscreen representation of what
the printed page will look like.

Print: This option prints the currently displayed map.

Recent Maps: Selecting this option displays a list of the maps you’ve most
recently created in this program.  To quickly reopen one of these maps,
click on the map name.

Exit: This option ends the current session of PeripheralVision®.

Edit Menu Options

Here is an example of the pull-down Edit Menu.
An explanation of the options follows.

Delete: This option deletes the currently selected agent from the
PeripheralVision® map screen.

Find: This option activates a search routine that helps you to find desired
devices from the map screen.  When selected, the Find Agents dialog box
appears, this is shown on the next page.
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Set the parameters for your search as follows:

Search on: Select the data field to search (Icon title, Host name, Hardware
address or IP address).

Enter the details of the agent to find: Type in the numbers, letters or special
characters of a string to search for.

Clear Existing Highlights: Select this button to remove all highlights from
previous searches.  Selecting this button will not delete any of the highlighted
information - it simply removes the highlighting used to identify information
matching the search criteria.

Refresh highlights before search: Select this option to have all highlights
from previous searches cleared before beginning a new search.

Case Sensitive: Select this option to search for only the indicated case of
letters (capitalized or not).
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View Menu Options

Here is an example of the pull-down View
Menu.  An explanation of the options follows.

Graphs: Choosing this option will take you into the Graph Wizard.  To
create a graph, follow the step-by-step instructions as explained in the
Graph Wizard (see Chapter 4 for further details).

Log File: When you select this option, the Log File Viewer will appear on
your screen.  This automatically keeps track of network activity and logs
“events” that have occurred on the network.  To leave the Log File Viewer,
select Close.

Toolbar: Choosing this option causes a popup menu to appear with a list of
options for toolbar appearance.  You can choose either Large or Small
Icons for the PeripheralVision® Toolbar.  You can also hide the Toolbar by
choosing No Toolbar.

Actions Menu Options

Here is an example of the pull-down
Actions Menu.  An explanation of the
options follows.

New Agent: Use his option to create a new agent icon, as follows:

1 Click on New Agent.  The mouse pointer will appear as a cross when it is
positioned over the map screen.

2 Left-click in the map screen to open the Agent Property Pages dialog
box.  Setup the properties for the new agent as you require.
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Find this Machine: This option autodiscovers your computer, opening the
Locate home PC dialog box.

New Cable: Use this option to create a new cable icon (see Chapter 5 for
further details).

Cable by IP network: This option activates automatic cabling of agent
icons according to the networks they belong to.

Sort Current Agents: Selecting this option opens the Arrange Icons dialog
box, which has two options for arranging devices on the map screen.

1 Arrange by IP address: This option sorts device icons in sequence
from left-to-right and top-to-bottom by their IP Addresses.  All
current cabling will be recabled and the colour of cables may change.

2 Arrange by cable node: This option sorts all device icons on the
map screen by their network nodes, arranging them from top-to-
bottom (following a repeating pattern of  left-to-right and then right-
to-left).  Current cabling will be recabled and the cable colour may
change.

Refresh Agents Now: This option allows PeripheralVision® to instantly
update the status of all devices on the network.  Refresh Agents Now does
not discover new devices - it checks devices already discovered to see if
they are still “alive” on the network.  For more information on refreshing
agents, see the topic Set Refresh Rate in the Discovery menu topic.

Discovery Menu Options

Here is an example of the pull-down
Discovery Menu.  These options
allow an alternative access to the
toolbar discovery icons which are
explained fully in Chapter 2.
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NPMP: This option autodiscovers NPMP™ agents on the network,
accessing the NPMP™ discovery dialog box.

Ping: This option autodiscovers all agents at the specified IP Address(es).
When selected, the Ping IP Address(es) dialog box is accessed.

Search DNS: This option autodiscovers all agents using the DNS.  When
selected, the DNS Agent Discovery dialogue box is accessed.

Set Refresh rate: This option sets the frequency for updating the status of
all agents on the network.  This option does not discover new devices -  it
simply checks devices already discovered to see if they are still “alive” on
the network.

Search Returns Window: This option displays the results and gives
feedback on your latest search for agents on a network.

Tools Menu Options

Here is an example of the pull-down
Tools Menu.  An explanation of the
options follows.

SNMP Tree Walker: This option starts the SNMP Tree Walker, a separate
application that enhances the functionality of PeripheralVision®.  Multiple
executions of the SNMP Tree Walker can be run simultaneously to monitor
different SNMP Trees, or networks (for more information, see Chapter 6).

Send Email: This option launches an email application, if one is installed.
You must provide the email application which is not included in
PeripheralVision®.  PeripheralVision® simply has the ability to start such
applications.
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Help Topics: This option displays the Help Contents page for
PeripheralVision®.

Register Product: This option displays the Product Authorisation and
Licence Transfer dialog box (for more information see Chapter 7).

About PeripheralVision: This option displays the program information for
PeripheralVision®.

Launch Web Browser: This option launches an Internet Web browser, if
one is installed.  You must provide the web browser application which is
not included in PeripheralVision®.  PeripheralVision® simply has the ability
to start such applications.

DNS Lookup: This option determines IP Addresses and host names (or
text domain names).  This is not the same function as Search DNS described
under the Discovery Menu.  You don’t have know the IP Address of a
network or agent to discover it.  This feature allows you to specify either an
IP Address or a Host/Domain name to discover networks and agents (for
further details see Chapter 2).

External Applications: Select this to see a list of applications for managing
specific types of agents available for your use.  This list can include
applications such as PlotPro or Overcom.

Options: This option opens the PeripheralVision® Options Properties pages.
For further details see Chapter 4.

Help Menu Options

Here is an example of the pull-down
Help Menu.  An explanation of the
options follows.
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Appendix B

TCP/IP Protocol
TCP (Transmission Control Protocol) and IP (Internet Protocol) are terms
that have generally become interchangeable.  TCP/IP protocol allows for
individual computers and computer networks to communicate with each
other.  The success of TCP/IP is due to three main factors:

1 Because TCP/IP is available on a wide range of computers, it is an
attractive option for new products.  Manufacturers can guarantee that
these products will work with many systems.

2 TCP/IP encompasses a broad range of extremely powerful and flexible
protocols, making it suitable for just about any task.

3 IP is the protocol set used by the Internet.

TCP/IP describes two protocols.   TCP offers a guaranteed delivery service
on top of IP, which is the core datagram service.  Improvements in TCP/IP
are occurring frequently, with increased functionality constantly being
added.  This makes TCP/IP a powerful protocol but has also created a
negative side effect.  Many people incorrectly call TCP/IP simply IP, however,
TCP/IP actually comprises a larger range of protocols and functionality
than IP alone.

Moreover, because TCP/IP is required for a wide range of environments,
some configuration may be needed to get it running on any given network.
For example, a server name and network number may be required.  For
bigger networks, the network configuration required involves ensuring
that each network unit has a unique number.  With just IP, however, several
server processes may be necessary.   You may need to tell new workstations
about the network configuration or provide translation services between
host names and their IP addresses.

Installation Notes
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The Basics of TCP/IP

The core of TCP/IP is the host address, also known as the IP address of a
machine.  Every machine on your network that is running IP needs a unique
host address.  There is no distinction between workstations, printers, routers
or servers - they are all IP hosts.  If you are familiar with local networks, you
will know that each workstation and server also has a unique address
which is set automatically.  With IP you have to set these yourself.  Networks
also include the concept of the network number.  There is a similar and
equally important concept in IP called the subnet address, but this is less
obviously identified - rather than typing in a network number, the address
of the subnet to which a machine is attached is embedded in its IP address.
All IP addresses are 32 bits, i.e.  four bytes long.  IP addresses are usually
written in decimal format, for example:

192.130.159.163

Associated with a particular IP address is the subnet mask.   This is used to
tell you how many of the leading bits in a given IP address denote the
subnet address, e.g.  the typical subnet mask of

255.255.255.0

means that the first three bytes of an IP address denote the subnet address,
and the last byte identifies a particular host on that subnet.  So with an  IP
address of:

192.130.159.163

and a subnet mask of:

255.255.255.0

the subnet address is:

192.130.159
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and the host identifier is:

163

Such a subnet address is known as a Class C network.  This means you can
have up to 256 different host addresses on that subnet (using 0 and 255 is
a bad idea, however, as these can conflict with other network services.  In
practice, it is best to use a range of 1 to 254, giving 254 total addresses).
Class B networks use a subnet mask of:

255.255.0.0

giving two bytes worth of addresses (65,536) for potential use.   There are
also Class A networks with a subnet mask of:

255.0.0.0

giving three bytes worth of addresses.

If your TCP/IP network is never going to be connected elsewhere, you can
use whatever subnet mask and IP addressing structure you want.  Do not
use 0 or 255 for IP addresses as these are used by network services, as is
127.x.x.x.  But typically, you will want to attach your network to the Internet
via an ISP (Internet Service Provider).

Usually, the ISP will supply you with a unique Class C address.  They will
give you a three byte address which you can use with a subnet mask of:

255.255.255.0.

You can then use the remaining byte in the address to identify the hosts on
your network.  If you have more than 255 hosts, you can ask for a Class B
address, but these are running out quickly, so you will have to justify your
reasons for needing one.  You will probably have to settle for two or more
Class C addresses.  Class A addresses are reserved for organizations such
as the US Department of Defense.
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Name Servers

If you have used the World Wide Web (WWW), you will know that most
sites have a name.  Although all you need to know is the host’s name, the
IP stack also needs to know the host's address.  The translation between
the host’s name and its IP address (and vice versa) is provided by a DNS
(Domain Name Server).  The DNS is a software process running on a network
machine that provides a lookup service for IP protocol stacks.

There are utilities allowing you to query a DNS directly, but generally this
is done “behind the scenes”.  If your network is completely standalone,
you will need to have your own DNS somewhere on your network.  However,
if you have an Internet connection, your ISP will have at least one DNS on
your side of the connection.  This adds resiliency and reduces the amount
of traffic over the Internet connection.  PeripheralVision® has a DNS Lookup
facility to enable you to search a DNS.

A single DNS, even one for an ISP, will not have the names and IP addresses
of the millions of hosts on the Internet.  Therefore, you configure your
hosts with a list of several DNS services - your ISP can provide you with a
list.  If the host cannot find the address it is looking for in the first listed
DNS (typically your local one) it tries the next one in the list.  If the address
cannot be located after the entire list has been searched, you will receive a
message stating that it cannot be found.
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Glossary

Appendix C

Address - One or more characters specifying the recipient or originator of
transmitted data.  An address can also denote the position of either data in
the computer memory or  the data pack itself while it is in transit through a
network.

Administrator - The individual responsible for managing the LAN.  This
person configures the network, maintains the shared resources and security,
and assigns passwords and privileges.

Agent - A software-driven process running on a communications or
networking device that allows that device to participate in a network
management system.  For example, an SNMP agent running on a router
allows the router to exchange information with an SNMP network
management system through the use of  SNMP protocol.

AppleTalk - A seven layer protocol stack developed by Apple for
communication amongst its Apple Macintosh products.

ARP (Address Resolution Protocol) - The Internet and TCP/IP protocol
used to dynamically bind a high level IP address, such as an Internet address,
to a low level physical hardware address (12-digit node address assigned
to all hardware).

AUI (Attachment Unit Interface) - The IEEE802.3 specified cable and
connector used to attach devices to a MAU.  Defined in section 7 of the
802.3 standard.

10Base2 - A form of Ethernet and IEEE 802.3 network cabling using thin
co-axial.  It refers to 10 Mbit/s speed BASEband transmission over 200
metres maximum length - in practice 185m - and is commonly known as
Cheapernet.
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10Base5 - Ethernet and IEEE 802.3 network cabling using thick co-axial
with 10 Mbit/s speed BASEband transmission and 500m maximum length.

10BaseT - Ethernet and IEEE 802.3 network twisted pair cabling with 10
Mbit/s speed BASEband transmission and a maximum length of 100m.

100BaseT - Several Fast Ethernet 100 MBps CSMA/CD standards for twisted
pair cables; all are standards (or planned standards) under IEEE 802.3.
They including: 100BaseTx (100 Mbps over two-pair Cat5 or better cable),
100BaseT4 (100 Mbps over four-pair Cat3 or better cable), 100BaseT2 (in
committee; 100 Mbps over two-pair Cat3 or better cable).

Bindery - A database that contains definitions for entities such as users,
groups and workgroups in the Novell NetWare LAN network operating
system environment.  The bindery supports the design, organisation and
secure operation of the NetWare environment.

Datagram -  A method of sending data with parts of the message sent in
random order.  The recipient machine reassembles the parts sequentially.

DNS (Domain Name System/Server) - The on-line distributed database
system used by the Internet to map names into IP addresses.  Internet DNS
servers implement a hierarchical name space which gives sites freedom
when assigning machine names and addresses.

Domain - A group of  network nodes forming an administrative entity or a
number of servers grouped together and named to simplify network
administration and security.  Every computer on a LAN belongs to at least
one domain.  However, logging on to one domain does not limit resources
in other domains in which the user has access permission.

Duplex - Simultaneous, two-way independent transmission of data.

Electronic mail, Email - The electronic transmission and reception of
messages and text-based information without the need for the recipient to
be present at the time of the transmission.

Ethernet - The most widely used LAN transmission network.  Based on a
bus network topology, it runs at a maximum 10 Mbit/s - in practice far less
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- and adopts CSMA/CD techniques operating over conventional co-axial
cable, thin wire co-axial cable and Unshielded Twisted Pair cabling.  A fibre-
optic implementation has also been defined.  Ethernet has been standardised
by the IEEE as the IEEE 802.3 standard.

Fileserver - A computer attached to a LAN running a Network Operating
System (NOS). The NOS allows the fileserver to regulate communications
among the workstations connected to it on the LAN and to manage the
shared resources available on the file server, such as hard disk storage and
printers.  A fileserver may be dedicated: the computer is used only as a
fileserver, or non-dedicated:  the underlying computer that the NOS runs
on is used for another task simultaneously.

FTP (File Transfer Protocol) - The standard, high level TCP/IP protocol
for transferring files from one machine to another across the Internet.

HTML (Hyper Text Mark-up Language) - The language used to create
documents on the World Wide Web.

Hub - The centre of a star topology network or cabling system.  A multi-
node network topology with a central multiplexer and many nodes feeding
into it through the multiplexer or hub (other nodes do not usually directly
interconnect).  LAN hubs are becoming increasingly popular with the growth
of structured cabling and the need for LAN management.

IAB (Internet Activities Board) - The technical body that sets policy and
standards for TCP/IP and the connected Internet suite of protocols.

IEEE - Institute of Electrical and Electronic Engineers: a US publishing and
standards organisation responsible for many LAN standards such as the
802 series.

IEEE 802.2 - The datalink standard for use with IEEE802.3, 802.4 and 802.5
standards.  It specifies how the basic data connection should be set up
over the cable.

IEEE 802.3 - The IEEE standardisation of Ethernet.  A Physical Layer
definition that includes specifications for physical cabling plus the
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method of transmitting data and controlling access to the cable.  It uses the
CSMA/CD access method on a bus topology LAN.

IEEE 802.5 - The IEEE standardisation of IBM Token Ring.  A LAN Physical
Layer standard that uses the Token Ring passing access method on a ring
topology LAN.

IEEE 802.6 - The standard that defines MANs.  The first installation will be
SMDS-based using short packet ATM transmission.

Interface - The place or piece of equipment where interaction occurs between
two systems or processes.

Internet - A group of interconnected networks appearing to be one
continuous network which can be addressed seamlessly at Network Layer
Three of the OSI model.  Typical internets are built using routers, either to
form a backbone router network or to link together LANs at the Network
Layer.

The Internet - A collection of networks and gateways all using the TCP/IP
protocol suite.  The Internet functions as a single, co-operative virtual
network.  It provides universal connectivity, three levels of network services,
connectionless packet delivery; full duplex stream delivery, and application
level services including email.

IP (Internet Protocol) - The TCP/IP standard protocol that defines the IP
datagram as the unit of information passed across an internet.  TCP/IP
provides the basis for connectionless packet delivery service.

IP Address - The 32-bit address assigned to a host allowing it to participate
in a TCP/IP internet.

LAN (Local Area Network) -  A communication system that links computers
together to form a network via (usually) a wire based cabling scheme.  LANs
connect PCs, workstations and servers together, allowing users to
communicate and share resources.  Devices linked by a LAN may be on a
floor of a building or on a campus.
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LANManager - LAN Network Operating System developed by Microsoft
which runs on top of OS/2 and Windows NT.

LAT (Local Area Transport protocol) - A DecNet specific protocol for
exchanging small packets of data typically between Dec Vax host computers
and terminal servers in a LAN.

MIB (Management Information Base) - The set of database variables that
a gateway running CMOT, SNMP or CMIP network management protocols
maintains.  MIB defines variables needed by the SNMP protocol to monitor
and control components in a network.  Managers fetch from or store in
these variables.  MIB-11 refers to an extended SNMP management database
that contains variables not shared by both CMOT and SNMP.  The CMIP
and SNMP MIB formats differ in structure and complexity.

Modem - A device named from an amalgam of the words modulator and
demodulator.  A modem will modulate an outgoing binary bit stream on an
analogue carrier and demodulate an incoming binary bit stream from an
analogue carrier.

Network interface - The point of interconnection between a telephone
network operator's communication facilities, terminal equipment, protective
apparatus or writing at a subscriber's premises.  This demarcation point is
on the subscriber's side of the phone company's protector or its equivalent.

Network Management - The process and techniques of remotely or locally
monitoring and configuring networks.

NPMP™ (Network Peripheral Management Protocol) - A transmission
protocol for TCP/IP based network management that facilitates access to
both configuration and statistical information.  NPMP™ also allows
alteration of the configuration data stored in an NPMP™ compliant network
peripheral device.

Octet - A grouping of eight bits in a packet switched network which is
similar, but not identical to, a byte.
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OEM (Original Equipment Manufacturer) - The maker of equipment
marketed by another vendor, usually under the name of the reseller.  The
OEM may make only certain components or complete devices, which can
then be configured by the reseller with software and/or hardware.

Packet - A collection of bits, including the address, data and control, that
are switched and transmitted together.  The terms “frame” and “packet” are
often used synonymously.

Port - A computer interface capable of attaching to another device, such as
a modem for communicating with a remote terminal.  If the port is within a
hub, it can attach to a workstation.

Printserver - A computer and/or type of software providing access to a
central printer for users on a network.  The printserver acts as a buffer,
holding the information to be printed in memory until the printer is free.
The printserver can be programmed to print the jobs in the order received
or to give priority to particular users who, in effect, “jump the queue.”
Printservers promote maximum exploitation of expensive resources such as
laser printers and save time by automatically retrying print jobs if the printer
is initially busy.

Printer driver - A program that controls printing and sets options such as
print quality and paper size for a particular printer.  For example, in
LANManager, each printer queue has a single printer driver associated
with it.

Protocol - A set of rules governing the information flow within a
communications infrastructure, often known as "data link control".
Protocols control format, timing, error correction, and running order.  Their
presence is essential when a device interprets incoming information.  Suites
of protocols are often used in networks, with each protocol responsible for
one part of a communications function.

RFC (Request For Comment) - A document series begun in 1969 describing
the Internet suite of protocols and related experiments.
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Repeater - A device that extends the maximum length of the cable used on
a single network.  In fibre networks, the repeater is an optoelectrical module
that receives an optical signal and converts it into electrical form.

RMON (Remote MONitoring) - A SNMP specification for multivendor
statistics gathered by a standards based (de facto SNMP) management
station from de facto standard RMON-compliant devices.

RJ45 - The popular name for the 8-pin modular connector in the 10BaseT
standard for UPT connections to workstations or smart wiring hubs.  The
actual connector is described in ISO standard 8877.

Router - A network interconnection device operating at OSI Network Layer
(Level Three) that supports a particular Network Layer protocol and related
stack, such as TCP/IP, DECnet, XNS, SNA, OSI IP, IPX.  Routers usually
support multiple protocols by a variety of methods such as Protocol
Independent Routing.  A router can be used to link LANs together locally
or remotely as part of a WAN.  A network built using routers is often termed
an internetwork.

Simplex - A communications system or link which can carry a signal in only
one direction.

SNMP (Simple Network Management Protocol) - A transmission protocol
defined by the IAB in RCF1157 for TCP/IP based network management,
widely accepted as a de facto standard for LAN network management.
SNMP is used to monitor IP gateways and the networks to which they
attach.  It defines a set of variables that the gateway must keep and specifies
that all operations on the gateway are a side-effect of fetching or storing to
the data variables.  SNMP consists of three parts: Structure of Management
Information (SMI), Management Information Base (MIB) and the protocol
itself.  The SMI and MIB define and store the set of managed entities;
SNMP conveys information to and from these entities.  The public domain
standard is based on the operational experience of TCP/IP internetworks
within DARPA/NSFnet.
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Sitecode - The registration code unique to each workstation or PC.  You
give your sitecode to your supplier when you licence software to a machine.

TCP/IP (Transmission Control Protocol/Internet Protocol) - The suite of
protocols used and developed by DARPA and the US DoD.  The protocols
build up to and include Layer Four of the ISO OSI model, but there is no
direct correspondence layer for layer.  Three main protocols sit above TCP/
IP: TELNET, FTP, and SMTP.

TELNET - The TCP/IP standard applications-level protocol for remote
terminal connection service.  Telnet allows a user at one site to transparently
interact with, or pass through to a remote network or time-sharing system
at another site, while appearing as a local terminal.

WAN (Wide Area Network) - A network covering a larger geographical
area than a LAN where telecommunications links are implemented, and
normally leased from the appropriate Public Telecommunications
Operator(s).  Examples of WANs include packet switched networks, public
data networks and Value Added Networks.

WBEM (Web Based Enterprise Management) - WBEM integrates common
but disparate standards - including SNMP, the simple network management
protocol, DMI , the desktop and server management interface, and HTTP,
the hypertext transfer protocol for Internet communication - into an
architecture that any web browser can  manage.

Windows - The Microsoft standalone operating system with an integral
graphical user interface which runs on top of MSDOS.

Windows NT (New Technology) - Microsoft's scalable 32-bit version of
Windows aimed at high-end workstation users.  Windows NT can be a
standalone operating system.  It can also be a "network ready" system
capable of acting as a small application server for a workgroup of Windows
- based PCs.  Windows NT incorporates Windows 3.1 and WFWG.


